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PREFACEPREFACE

The computer has become an integral part of our society. It has influenced almost 
every aspect of our lives; be it work or leisure. It is only through computers that we 
are able to organise and execute even the simplest of tasks. 

Snapshot is a series of five books for classes 1 to 5, which brings together ‘knowledge’ 
as well as ‘knowledge application’. Each book is based on Windows 10 and MS 
Office 2016. The books are integrated with National Curriculum Framework (NCF) 
2022.

In classes 1 and 2, students will gain basic knowledge of computer and its devices. 
They will also get to implement their creativity in Tux Paint and MS Paint. 

In classes 3, 4 and 5, students will enhance their skills by gaining knowledge about 
MS Word, MS Excel, MS PowerPoint, LOGO, Scratch, E-mail, Internet, Artificial 
Intelligence and Logical Reasoning.

Through this book, we want to promote modern ways of teaching in which the 
student gets to comprehend and implement knowledge as well as technical 
skills. Rather than restricting the inflow of knowledge to verbal teaching, we have 
included all kinds of activities to further add to the independence of students so 
that they can learn better.

Each chapter is introduced in a systematic manner. The illustrations, application 
screenshots, activities and exercises are curated in simple language to assist the 
teaching-learning process.

—Author
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PLAY-BASED LEARNING Inclusion of word puzzles such as word search, 
crosswords, word jumbles

ETHICS and VALUES Ethics and values like empathy, respect for others, 
equality, and justice

SOCIAL and EMOTIONAL 
LEARNING (SEL)

Self-awareness, Self-management, Decision-making, 
Social awareness, Relationship skills

COMMUNICATION Exchange of information, thoughts, and ideas

EXPERIENTIAL 
LEARNING Hands-on approach, learning through experience

CREATIVITY Imagination, organization, problem-solving,  
innovation

TECHNOLOGY and 
EDUCATION

Extensive use of technology in teaching and  
learning

CRITICAL THINKING Application of logic and reasoning in  
decision-making

Integrated with NCF 2022

DIGITAL AID

EL

PL

EV

SEL

CM

CR

TE

CT

Student’s Assist Teacher’s Assist

Audio and Video eBook
◊	 Features of a computer

	Student Worksheets

Test Paper Generator
◊	 Random and Manual Question Paper
◊	 Download papers in Word format

	 Lesson Plans

	Worksheets

	 Answer Key
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Salient Features

Chapter

7Chapter	1	I	Computer—A	Wonderful	Machine

1

LEARNING OBJECTIVES

In this chapter, students will learn about:
Natural	and	man-made	things
What	are	machines?
Computer—A	wonderful	machine
Why	is	computer	a	unique	machine?

SIGN IN

Colour the pictures.

Look at the two pictures you have coloured. Are they same?  
If not, then how are they different?

Yes,	they	are	different.	A	house	is	made	by	man	and	a	tree	is	a	natural	
thing.	In	this	chapter,	let	us	learn	about	natural	and	man-made	things.

 Computer—A Wonderful Machine

Scan QR Code to
watch a video
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Learning Objectives  
(Lesson Outline)

Activity Time  
(Creative Learning)

News Feed  
(Additional Information)

Sign In  
(Link to the Concept)

Refresh  
(Summary of the Lesson)

Let’s Explore  
(Practical Implementation)

37Chapter 4 I The Keyboard

Make the buttons of a keyboard

How to make—
• Take a chart paper. 
• Cut it into square pieces. (Ask your teacher or an adult for help.)
• Write one letter (A to Z) or number (1 to 10) on each piece. 

These are the buttons of your keyboard.
• Now, take another chart paper and paste the letters of your 

name and number of your birth date.

Name: 

Birth date (Birthday):

ACTIVITY TIME

• A keyboard is used to type on a computer.
• There are many keys on a keyboard.
• Alphabet keys are used to type letters.
• Number keys are used to type numbers.
• Some of the special keys are Arrow keys, Enter key, Spacebar 

key, Backspace key and Caps Lock key.

REFRESH

• Spacebar is the only key with nothing written on it on the keyboard.

NEWS FEED
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15Chapter	1	I	Computer—A	Wonderful	Machine

	 4. 	 It	is	used	to	talk	with	other	people.

     

	 5. 	 It	is	a	machine	with	colourful	beads.

     

a. b. c.

a. b. c.

•	 Roam	around	in	various	places	at	your	school.	Find	out	different	
types	of	machines	in	your	school.

LET'S EXPLORE

•	 Show	the	students	different	types	of	machines	such	as	mobile,	
refrigerator,	water	cooler,	air	conditioner,	vehicles,	etc.	which	can	
be	found	in	school.

•	 Also,	take	the	students	to	the	computer	lab	and	show	them	a	
computer	and	its	various	parts.	Explain	some	of	the	things	that	we	
can	do	using	a	computer.

FOR THE TEACHER
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91Periodic Assessment–4

PERIODIC ASSESSMENT 4
A. Identify the shapes and write their names.

	  	   		 	 	 		 	  

  1.    2. 

	 	          

  3.    4. 

B. With the help of the clues complete the words in the puzzle.

 Across →
2. It is a repeating arrangement.
4. It is the ability to learn.
5. Toy AI

Down ↓
1. It is a puzzle.
3. Voice AI

1 W

2 P

3 A
4 I E

5 A
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93Chapter 9 I Introduction to Artificial Intelligence

A. Draw the following in Tux Paint.

PROJECTPROJECT

B. Draw the following in MS Paint.
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92 Test Paper–2

TEST PAPER 2TEST PAPER 2

A. Tick (ü) the correct option.

  1. It is a natural thing.

   a.   b.    c. 

  2. It is a tool of Paint.

   a.   b.   c. 

B.  Write True (T) for the correct statements and False (F) for  
the incorrect statements.

 1. Tux Paint has a variety of drawing tools.  

 2. Brushes tool is used to draw freehand in Paint.  

 3. A triangle has two sides.  

 4. A tree is a natural thing.  

 5.  Artificial Intelligence refers to the ability  
of the machine to think and learn. 

C. Answer the following questions.

 1. Name two programs that you can use to draw on a computer.

 2. Which tool is used to draw a circle in Paint?

 3. How can we make a pattern?

 4. Write the names of four tools used in Tux Paint.

 5. Define man-made things? Give two examples.
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94 Chapter 9 I Introduction to Artificial Intelligence

(Sample Paper)

LOGICAL REASONINGLOGICAL REASONING

1. Tick the correct option to complete the pattern.

 
18

 
15

 
12

 
9

 
?

  a. 10   b. 8     c. 7    d. 6 

2. Select the odd one out.

  a. 8–4  b. 9–5   c. 7–6   d. 6–2

3. Which of the following is the smallest?

  a.         b.  

  c.    d.  

NATIONAL CYBER OLYMPIADNATIONAL CYBERNATIONAL CYBER  OLYMPIADOLYMPIAD
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Periodic Assessments  
(Revision of Lessons) Test Papers 

(Evaluation of 
Knowledge)

Project  
(Application of 

Knowledge)

National Cyber 
Olympiad  

(Preparation for  
Cyber Competition)
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Chapter

7Chapter 1 I A Computer System

A Computer System1

LEARNING OBJECTIVES

In this chapter, students will learn about:

Features of a computer

A computer system—how does it work?

Input

Process

Output

SIGN IN

Look at the pictures and write 1, 2, and 3, according to the correct sequence.

Coffee Mixing coffee and milk Coffee and milk

Making a drawing
Paper, coloured  

pencil and eraserA drawing

A plantBeans, soil and waterPlanting

Scan QR Code to
watch a video

CT
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8 Chapter 1 I A Computer System

A computer is a smart machine. We use computer to 
do various activities such as playing games, watching 
movies, listening to music, drawing pictures, studying, 
storing information etc.

A computer is used to do various tasks at  
different places such as:

•	 At home, it is used to watch movies and do 
assignments.

•	 In school, it is used by both teachers and 
students.

•	 In offices, it is used to type documents.

•	 In shops and restaurants, it is used to keep records and make bills.

•	 In hospitals, it is used to maintain medical records and examine X-rays.

•	 At railway stations and airports, it is used to book tickets and give information.

FEATURES OF A COMPUTER
It has many important features that make it a smart machine.

Speed
A computer works with a higher speed compared to humans. It 
can do calculations at a very high speed.

Accuracy
A computer does not make mistakes. It gives accurate results.

Diligence
A computer can work for a long duration with the same efficiency. 

Teacher and students working 
on computers at school

Nurses using computer 
 in hospital 

Booking ticket using 
computer

A shopkeeper using 
computer
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9Chapter 1 I A Computer System

The first fully operational digital computer is Z1 developed by Konrad Zuse  
in 1936. 

NEWS FEED

Reliability
A computer gives consistent results for a similar set of data.

Memory
A computer has a very large memory which can store a large  
amount of information. The information can be accessed  
quickly when it is required. 

Multi-tasking
A computer can do various tasks simultaneously without getting tired.

A COMPUTER SYSTEM: HOW DOES IT WORK?
A computer works on the Input-Process-Output (IPO) cycle.

Input Process Output

It means that a computer receives an input, processes the information and then 
gives the output. For example, calling a friend on a phone:

•	 Input: dial a number

•	 Process: the phone processes the command and connects the number

•	 Output: speaking to your friend
A computer system is made up of various devices such as keyboard, mouse, 
monitor, CPU, printer scanner, etc. These devices perform different works. 
The input or the instruction is entered through a mouse or keyboard. The CPU 
processes the command and the output is displayed on the monitor. 

INPUT
Input is the data or the instruction that the computer receives. The device that 
is used to send input to a computer is called an input device. Keyboard, mouse, 
scanner, camera or webcam are some of the input devices. 

CM
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10 Chapter 1 I A Computer System

Keyboard Mouse Scanner Webcam

Some other examples of input devices are:

Joystick
It is an input device used for playing games. It is a cursor control 
device that helps to move the items on the screen.

Light Pen
It is a pen that is used on a special pad. The text or drawing we 
make on this pad is visible on the monitor.

PROCESS
The input that the computer received is processed with the help 
of the processor in the CPU. Processing means the conversion of 
data entered by the user to produce meaningful information.

The CPU is also called the brain of the computer. It has 
three parts—Arithmetic and Logic Unit, Main Storage, and 
Control Unit.

Arithmetic and Logic Unit (ALU)
Arithmetic and Logic Unit (ALU) performs various arithmetic calculations such 
as addition, subtraction, multiplication and division. It also performs logical 
operations such as comparing (greater than, less than, equal to, etc.), selecting 
and matching data.

Memory Unit (MU)
The Memory Unit (MU) stores all the information and data given to the computer. 
It also stores the data required for processing and the final result of the 
processing.

Joystick

Light Pen

CPU

Computer G3_Ch-1.indd   10Computer G3_Ch-1.indd   10 27-02-2023   10:10:3227-02-2023   10:10:32



11Chapter 1 I A Computer System

Control Unit (CU)
The Control Unit (CU) coordinates the operation between the function of all the 
parts of the computer. It controls the transfer of data and instruction from the 
memory unit to the ALU.

OUTPUT
The output is the final result we get after processing the input. The device on 
which the output is displayed is called the output device. Monitor, printer and 
speaker are some of the output devices. The output which is displayed on the 
monitor is called soft copy. When this soft copy is printed on paper, it is called 
the hard copy. 

Monitor Printer Speaker

Some other examples of output devices are:

Plotter
It is a printer used to print large-size papers.  
They are usually used for flex printing.

Touch Screen
It is a computer screen that can be operated by 
touching on it. We can give the input by touching 
the screen with our fingers without using any pointing 
device. Some of the devices that have touch screen are 
tablets, laptops, cell phones and ATMs. It is used as both 
an input and output device. 

Plotter

Tablet
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12 Chapter 1 I A Computer System

The computer monitor was invented in 1897 by Karl Ferdinand Braun.

NEWS FEED

Find the names of 10 computer devices. The names are hidden horizontally, 
vertically and diagonally.

ACTIVITY TIME

C K M E E A Y J P H P L Z E R R F Z
B A V A V Z D O L U A H T H K P K W
U G M O P O A Y S P F S I Z Q Y S M
F N B E X V Y S K E Y B O A R D P O
J C N A R D N T K N S G J I S P E T
J W G E D A Q I Z D X K P H S D A G
D K D V A Y N C N R P K W T S I K H
P R | N T E R K L I L L T T E A E B
L J R P D D U A T V C Y M U P V R P
H Z P L O T T E R E I R A T C N U L
T D K S C A N N E R M O N I T O R W
K C W B O W U J X H A R D D I S K D

STORAGE
Storage means to store or retain the data after processing for further use. 
The data can be stored either temporarily or permanently. The device used to 
store the data is called a storage device. Hard disks, pen drives and CDs are 
some of the storage devices.

Pen Drive 		  Hard Disk 		  CD

CM

PL
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13Chapter 1 I A Computer System

•	 A computer is used to do various tasks in different places such as at home, 
hospitals, in schools, offices, etc. 

•	 A computer can work accurately and with faster speed.

•	 A computer can store a large amount of information and can do many 
things simultaneously. 

•	 A computer works on the Input-Process-Output (IPO) cycle.  

•	 The device that is used to send input to a computer is called an input device.

•	 CPU is a processing device.

•	 CPU has three parts—Arithmetic and Logic Unit, Main Storage, Control Unit.

•	 The device on which the output is displayed is called the output device.

REFRESH

BROWSE

A 	 Choose the correct option.

	 1. 	� The information that we send to a computer is .

		  a. 	 input	 	 b. 	 output	 	 c. 	 process�

	 2. 	 ALU stands for .

		  a. 	 Arithmetic and Logic Unit 

		  b. 	 Arithmetic and Log Unit     

		  c. 	 Analytical and Logic Unit 

	 3. 	 These are the three parts of CPU .

		  a. 	 ALU, MU, CU	 	 b. 	 AUL, MU, UC	 	 c. 	 ALU, UM, CU�
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14 Chapter 1 I A Computer System

	 4. 	 The output when printed on a paper is called .

		  a. 	 soft copy	 	 b. 	 hard copy	 	 c. 	 copy�

	 5. 	 Touch screen is .

		  a. 	 input	 	 b. 	 output	 	 c. 	 both a and b�
			   device			   device

B 	 Fill in the blanks with the words given below.

	 Processing      Plotter      three      Light Pen      process

	 1. 	 A CPU has  parts.

	 2. 	 IPO stands for Input- -Output.

	 3. 	  is a pen used on a special pad.

	 4. 	�   means the conversion of data entered by the 

user to produce meaningful information. 

	 5. 	  is a printer used to print large size page.

C 	 Write T for true statements and F for false statements.

	 1. 	 A computer works slower than a human.	

	 2. 	 A computer gives consistent results for the same set of input.	

	 3. 	 Input is the result we get after processing.	
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15Chapter 1 I A Computer System

	 4. 	 Touch screen is only an input device.	

	 5. 	 A storage device is used to store data. 	

D 	 Answer in one word or two words.

	 1. 	 I�t is the part of the CPU that does the  

arithmetic calculation.�

	 2. 	� It is the part of the CPU that stores all  

the information.�

	 3. 	� It is the part of the CPU that controls the  

transfer of data.�

	 4. 	� It is an input device used for  

playing games.		� 

	 5. 	 It is the output we see on the monitor.�

E 	 Answer the following questions.

	 1. 	� Write five features of computers.

	 2. 	� What are the input devices? Give two examples.

	 3. 	� What are the output devices? Give two examples.

	 4. 	� Give an example of the Input-Process-Output cycle. 

	 5. 	� What is ALU?
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16 Chapter 1 I A Computer System

Name the parts of the computer. Also, label each computer part as input or 
output. 

ACTIVITY TIME

Write a thank you letter to your teacher. Go to the computer lab and type it on 
a computer. Print it and give it to your teacher.
In this process, identify:

•	 what is the input?

•	 what is the process?

•	 what is the output?

•	 which is soft copy?

•	 which is hard copy?
Also, identify the input devices, processing devices and the output devices.

LET'S EXPLORE

•	 Recapitulate the features and uses of computers.

•	 Explain the working of a computer.

•	 Show the students the various types of Input. Output and Storage devices.

FOR THE TEACHER

CT

ELTE
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17Chapter 2 I Computer Software

Computer Software2

LEARNING OBJECTIVES

In this chapter, students will learn about:

Hardware—Input, processing, output and storage devices

Software—System and Application software

SIGN IN

Observe the pictures. Circle the objects that you can touch. 

Scan QR Code to
watch a video

CT
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18 Chapter 2 I Computer Software

Input Devices: 

Processing Device:

Output Devices:

A computer system has different components that work together. These 
components can be grouped into two categories—Hardware and Software.

HARDWARE
Computer hardware is the part of a computer system that we can touch and 
feel such as a mouse and keyboard. It refers to the physical parts of a computer 
system. All the input, processing, output and storage devices are hardware.

Input Devices Processing Devices Output Devices Storage Devices

Hardware

Keyboard

CPU box

Printer Monitor

CPU

Speaker Headphone

Mouse Scanner
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19Chapter 2 I Computer Software

Storage Devices:

SOFTWARE
A computer needs instruction to work. The instruction that tells a computer what 
to do is called software or program. It is the part of the computer that cannot be 
touched or felt.

The input that we give to the computer is processed to get the output through 
software. Thus, software is a set of instructions given to the computer to do a 
specific task.

How does software work?
The data or the information that we put through the input devices is then 
processed in the CPU. The processing of input in the CPU is done by software. 
After processing, the output is displayed on the monitor. 

Let us look at an example to understand the difference between hardware and 
software.

When we watch a video on a phone, 
computer or television, there are two things 
that we need. One is the device, i.e., phone, 
computer or television which is physically 
present and we can touch it. Another is the 
video that will be playing on these devices, 
which we cannot touch. Here, the devices are 
the hardware and the video playing in these 
devices is the software.

Tom Kilburn, a computer scientist, developed the first software in 1948.

NEWS FEED

Hard Drive DVD Pen Drive

FPO

Watching a video on a television

CM
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20 Chapter 2 I Computer Software

Computer software is of two types— System software and Application Software.

System software Application Software

Software

System software
System software is like a manager of a computer system. It controls and 
manages the overall activities of a computer system. Its main function is to 
prepare the computer to work and run application software. 

System software is an important part of a computer system. A computer system 
would not work without system software. It makes the computer run. When we 
start the computer, the system software also starts with it.  

An example of system software is an operating system. The most popular 
operating system is Microsoft Windows. It is also called Windows and Windows 
OS. There are different versions of Windows—Windows XP, Windows Vista, 
Windows 7, Windows 8, Windows 10 and Windows 11. Windows 11 is the latest 
version which was released in October 2021. 

Windows 7 Windows 10 Windows 11

There are other types of operating systems such as Linux and Mac OS.

Linux Mac OS
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21Chapter 2 I Computer Software

Application Software
The software that helps us to perform a specific task is called the application 
software. Some of the popular application software are Microsoft Word, 
Microsoft PowerPoint, Paint and Microsoft Media Player. Each of this application 
software can perform only the task that it is specifically designed for. 

Let us look at the examples below to understand the function of some application 
software.

Microsoft Word

•	 Microsoft word or MS Word is an application to create 
documents. It is used to type letters, essays, articles, etc. 

•	 In this application, we cannot play a movie or a song 
in it.

•	 There is different software designed to play movies 
and music.

Windows Media Player

•	 Windows Media Player is one of the software developed 
to play movies and music. 

•	 When we want to watch a movie on a computer, we have 
to open this software.  

Microsoft PowerPoint

•	 Microsoft PowerPoint or MS PowerPoint is an 
application to create presentation.

Computer Usage Company (CUC) is the world’s first computer software 
company, founded in March 1955.

NEWS FEED

MS Word

Windows Media Player

Microsoft PowerPoint

CM
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Paint
Paint is an application or program to draw and colour 
a picture.  

Write the software under the correct column.

Microsoft Word      Windows 10      Microsoft PowerPoint 
Linux      Windows Media Player      Paint      Mac OS

ACTIVITY TIME

Paint

System Software Application Software

•	 The components of a computer system can be grouped into two categories—
Hardware and Software.

•	 Hardware are the physical parts that can be touched and felt.

•	 All the input, processing, output and storage devices are hardware.

•	 Software is a set of instructions given to the computer to do a specific task.

•	 Computer software is of two types—System software and Application Software.

REFRESH

CT
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BROWSE

A 	 Choose the correct option.

	 1. 	� It is a hardware.

		  a. 	 Pen Drive	 	 b. 	 Windows	 	 c. 	 Paint�

	 2. 	 It is a hardware which is an output device.

		  a. 	 CPU	 	 b. 	 Mouse	 	 c. 	 Monitor�

	 3. 	 It is an example of system software.

		  a. 	 Windows 7	 	 b. 	 Window 10	 	 c. 	 Both a and b�

	 4. 	 It is an example of an application software.

		  a. 	 MS Word	 	 b. 	 Windows 10	 	 c. 	 Windows 7�

	 5. 	 It is an operating system.

		  a. 	 Windows	 	 b. 	 MS PowerPoint	 	 c. 	 Windows 10�

B 	 Fill in the blanks with the words given below.

	 application      Software      system      Hardware      two

	 1. 	� The components of a computer system can be grouped into 

 categories.

	 2. 	  are the physical parts that can be touched and feel.

	 3. 	�   is a set of instructions given to the computer to do 

a specific task.

	 4. 	� The  software controls and manages the overall 

activities of a computer system.

	 5. 	 The  software is designed to do specific tasks.
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C 	 Write T for true statements and F for false statements.

	 1. 	 A computer system has only one part.�

	 2. 	� The components of a computer can be grouped into two  
categories.�

	 3. 	 We cannot touch the hardware.�

	 4. 	 We can touch the software.�

	 5. 	 Application software is designed to do a specific task.�

D 	 Answer in one word or two words.

	 1. 	 A hardware used as an input device.�

	 2. 	 A hardware used as a storage device.�

	 3. 	 A software used to make presentation.�

	 4. 	 A software used to watch movies.�

	 5. 	 A software used to type letter and document.�

E 	 Answer the following questions.

	 1. 	� What is hardware?

	 2. 	� Write the name of six computer hardware.

	 3. 	� What is software?

	 4. 	� How many types of software are there? Write the names. 

	 5. 	� Write the differences between application software and system 
software.
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Write the name of the software.

ACTIVITY TIME

1.

4.

3.

6.

2.

5.

•	 Discuss the different types of hardware—input, processing, output and 
storage.

•	 Explain the types of software to the students.

•	 Show the students different types of application software such as Paint, 
Windows Media Player, and Microsoft Word.

FOR THE TEACHER

Visit your computer lab and make a list of five software that are there in the 
computer. Then, with the help of your teacher open any two applications. 
Hints:

•	 Think about the programs used for drawing.

•	 Think about how you listen to music.

LET'S EXPLORE

CMCT

ELTE
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Introduction to Windows 103

LEARNING OBJECTIVES

In this chapter, students will learn about:

Windows 10

Features of Windows 10 

Desktop—Icons, Taskbar, Desktop background

How to change desktop background?

Task View

Control Button

Shut down Windows 10

SIGN IN

Match the places with the person who is the coordinator of these places.

1.

a.

2.

b.

3.

c.

4.

d.

Hotel Manager Principal Hospital Chief 
executive officer 

(CEO)

Superintendent  
of Police 

Scan QR Code to
watch a video

CRCT
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Microsoft was founded by Bill Gates and Paul Allen on April 4, 1975.

NEWS FEED

Operating System is one of the most important software in a computer system. 
It manages and controls all the functions of a computer and makes it run. 
A computer system cannot work without it.  Some of the popular operating 
systems are Windows 10, Mac and Linux.

In this chapter, we will learn about Windows 10.

WINDOWS 10

Windows is an operating system developed by Microsoft, which is a leading 
software company. Windows has many versions. Windows 7, Windows Vista, 
and Windows XP are some of the old versions of Windows. These older versions 
of Windows run only on desktop and laptop computers. Windows 10 is a newer 
version of Windows. It can be used as an operating system for desktops, laptops 
and mobile devices.  It is more user-friendly. It was released on 29 July 2015.

The latest version of Windows is Windows 11, released on 5 October 2021. 

FEATURES OF WINDOWS 10
Windows 10 is an advanced and popular operating system. It has amazing 
features. These are some of its features:

•	 Windows 10 has a Graphic User Interface (GUI). This makes it user-friendly 
as the work can be done with just a simple click of a mouse. GUI is picture-
oriented and you do not have to remember all the commands. 

•	 On Windows 10, several programs can be run at the same time.

CM
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•	 It has introduced Cortana, a voice-controlled digital assistant. 
This makes it easier to use our devices as it can be operated 
with our voice.

•	 It is easy to use.

DESKTOP—ICONS, TASKBAR, DESKTOP BACKGROUND
Windows start automatically when we start a computer. The screen that appears 
first when Windows start is the desktop. 

A desktop is an area on a computer screen where small labelled pictures or 
symbols are present. It is the main screen of an operating system. A desktop has 
three components—Icons, Taskbar and Desktop Background.

The first version of Windows, Windows 1.0 was released in November 1985 
by Microsoft.

NEWS FEED

Icons

ICONS
An icon is a small picture on the desktop that represents an application or a file. 
These are some common icons present on a desktop.

Taskbar

Desktop Background

Cortana

CM
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To open or access an icon, we have to double-click on it.

Selecting and deselecting an icon

•	 To select, click on the icon you want to select.  
It will be highlighted. 

•	 To deselect, click away from the icon. It will be 
displayed without the highlight. 

Sorting the icons	
Sorting the icons means arranging the icons in a 
proper sequence on the desktop. 

Follow the given steps to sort the icons:

•	 Right-click on the blank area of the desktop. A 
shortcut menu will appear. Click on the Sort by 
option.

•	 Click on the option you want to arrange. For example, if you click on the Name 
sub-option, the icons will arrange in alphabetical order.

TASKBAR
A taskbar is the long horizontal bar located at the bottom of the desktop. It has 
various components. It has the Start Button, Opened Programs or applications 
and Notification Area.

Selected icon

Opened Programs Notification Area

Show Desktop button

Start button
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•	 The Start button  is on the extreme left. It is used to open the Start menu.

•	 The middle section of the taskbar shows the opened applications or 
programs. 

•	 The right side of the taskbar is the Notification Area. It shows the date, time 
and other icons that provide information about network connection, charge 
level of the battery, volume, updates, etc.

•	 The Show Desktop button is on the extreme right. Clicking this button 
minimizes all the opened windows and displays the desktop.

Computer G3_Ch-3.indd   30Computer G3_Ch-3.indd   30 27-02-2023   10:24:2027-02-2023   10:24:20



31Chapter 3 I Introduction to Windows 10

DESKTOP BACKGROUND
Desktop background is the image used as a image that appears at the back of 
a computer screen. We can change the desktop background according to our 
choice. Do you want to keep your picture as a desktop background?

How to change the desktop background?
Follow these steps to change the desktop background:

1.	 Right-click on the blank area of the desktop. A shortcut menu will appear. 
2.	 Click on the Personalise option.
3.	 Click on the Background option on the left panel.
4.	 Choose the option you want from the Background section.
5.	 Choose how you want the picture to fit on the screen from Choose a fit 

section.
6.	 Choose the picture you want and click on it. This will automatically change the 

background. A preview of the desktop appears in the window.

Changed Desktop Background

1

3

2

4

6

5

Computer G3_Ch-3.indd   31Computer G3_Ch-3.indd   31 27-02-2023   10:24:2127-02-2023   10:24:21



32 Chapter 3 I Introduction to Windows 10

TASK VIEW
In Task View, we can see all the open windows. It allows us to switch between 
them. It also helps us to select any window to open quickly. To open Task view, 

click on the Task View button  located on the Taskbar. 

Task View

CONTROL BUTTONS
In the upper-right corner of every open window of an application, there are 
three control buttons. These buttons are used to minimize, maximize and close 
the window. 

Minimize Close

Maximize

Minimize: When we click on the minimize button, the window will hide in the 
Taskbar.

Maximize: When we click on the maximize button, the window will be of  
full-screen size. When the window is in full-screen size, the maximize button 
changes to the Restore Down button. Clicking on this will restore the window 
to its last size.

Close: When we click on this button, the application will close.
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STEPS TO SHUT DOWN WINDOWS 10
Windows should be shut down properly before switching off the computer.

Follow the steps given below to shut down the window:

1.	 Click on Start button. The start menu will 
appear.

2.	 Click on Power button that appears 
above the Start button.

3.	 Click on Shut down button.

Label the parts.

ACTIVITY TIME

1

3

2

CT
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•	 Windows is an operating system developed by Microsoft.

•	 Windows 10 is an advanced version of Windows, 29 July 2015.

•	 Windows 10 has a Graphic User Interface (GUI).

•	 A desktop is an area on a computer screen where small labelled pictures or 
symbols are present.

•	 An icon is a small picture on the desktop that represents an application or a file.

•	 A taskbar is the long horizontal bar located at the bottom of the desktop.

•	 A desktop background is the image that appears at the back of a computer 
screen.

•	 There are three control buttons in every open window—Minimize, Maximize, 
Close.

REFRESH

BROWSE

A 	 Choose the correct option.

	 1. 	� It manages and controls the operation of a computer.

		  a. 	 Operating	 	 b. 	 Application	 	 c. 	 Microsoft�
			   System			   software			   Word

	 2. 	 It is an Operating System.

		  a. 	 Windows	 	 b. 	 Words	 	 c. 	 Paint�

	 3. 	 It is the visual-assistant of Windows 10.

		  a. 	 Siri	  	 b. 	 Alexa	 	 c. 	 Cortana�
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	 4. 	 It is an icon.

		  a. 	 	 	 b. 	 	 	 c. 	 �

	 5. 	 It is a part of Taskbar.

		  a. 	 Control	 	 b. 	 Notification	 	 c. 	 Desktop�
			   Buttons			   Area			   background

B 	 Fill in the blanks with the words given below.

	 GUI      Desktop      left      Windows 11      icon

	 1. 	  is the latest version of Windows.

	 2. 	 Windows has a .

	 3. 	�   is the main screen of the Windows.

	 4. 	� An  is a small picture on the desktop that 

represents an application or a file.

	 5. 	� Taskbar is present on the  side of Notification 

area.

C 	 Write T for true statements and F for false statements.

	 1. 	 Windows 10 is the latest version of Windows.�

	 2. 	 Windows is an operating system.�

	 3. 	 A desktop has three components.�
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	 4. 	� A taskbar is the long horizontal bar located at  

the top of the desktop.�

	 5. 	 There are two control buttons in every open window.�

D 	 Answer in one word or two words.

	 1. 	� The area where the content of our work is  

displayed.�

	 2. 	 The part of the taskbar that displays the clock.�

	 3. 	 The small pictures on the desktop.�

	 4. 	� It is the image that appears at the back of a  

computer screen. �

	 5. 	� When we click on this, we can see all the  

open windows.�

E 	 Answer the following questions.

	 1. 	 What is Windows 10?

	 2. 	� What is an icon? How do you select it?

	 3. 	� Where is Taskbar located? Name its components.

	 4. 	� What is meant by desktop background?

	 5. 	� Write the steps to shut down Windows 10 properly.

Computer G3_Ch-3.indd   36Computer G3_Ch-3.indd   36 27-02-2023   10:24:2127-02-2023   10:24:21



37Chapter 3 I Introduction to Windows 10

Number the boxes in the correct sequence to change the background of 
a desktop.

ACTIVITY TIME

•	 Explain the features and different versions of Windows.

•	 Show the what icons are.

•	 Show them how to change the background of desktop.

•	 Show them how to shut down Windows.

FOR THE TEACHER

Go to the computer lab do these activities. (You can take help of your 
teacher.)

•	 Sort the icon according to name.

•	 Choose a picture and set the picture as desktop background.

LET'S EXPLORE

CT

ELTE
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PERIODIC ASSESSMENT 1

A.	 Identify the following images and write their names.

		  					   

		  1.  			   2. 

		  	 	 	 	 	  

		  3.  			   4. 

B.	 Fill in the blanks using the words given below.

	 DESKTOP    HARDWARE    ICON    APPLICATION    THREE

		  1.  A computer has  parts.

		  2. �   are the physical parts that can be touched  
and felt.

		  3.  The  software is designed to do specific task.

		  4.   is the main screen of Windows.

		  5. � An  is a small picture on the desktop that  
represents an application or a file.
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Introduction to  
Microsoft Word 20164

LEARNING OBJECTIVES

In this chapter, students will learn about:
MS Word—An Introduction
Uses of MS Word
Start MS Word 2016
Components of MS Word 2016
Create a new document
Type text in a document
Save a document
Open a saved document
Print a document
Exit MS Word

SIGN IN

What do we need to write? Name three items that you use to write.

1. 	

2. 	

3. 	

Can we make changes if we make a mistake while writing? 

	 Yes 				    No 
If yes, what do you use to make the correction?

Scan QR Code to
watch a video

CR CT
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We use computers to type text. What do we need to type text on a computer? 
We need an application software or a program. Software on which we can 
create, edit and print documents is called Word Processor software. One of the 
most common word processor software is Microsoft Word (MS Word) or simply 
Word. Microsoft word has many versions such as Word 2007, Word 2010, Word 
2016, etc. In this chapter, we will learn about Word 2016.

MS WORD—AN INTRODUCTION
MS Word is an application software that we use to type text on a computer. It 
was developed by Microsoft. The Word allows us to type text on a computer. 
Word 2016 is one of the advanced versions of Word that has many features 
which make it easy to use.

USES OF MS WORD
Word is a very useful application and we can do many things using it. Some of 
the things we can do using Word are:

•	 To type text and create documents such as notes, letters, assignments, 
stories, etc.

•	 To make changes in the document while typing or after the typing.

•	 To make a document interactive with different features and tools such as 
colours, styles and effects.

•	 To detect grammatical and spelling errors.

•	 To add text, copy and move if required.

•	 To save the document for future use.

•	 To print a document or a part of it.

START MS WORD 2016
Follow these steps to start Word 2016:

1.	 Click on the Start button.
2.	 Scroll through the list of programs and click on Word. A new window will appear.
3.	 Click on New.
4.	 Then click on Blank document. The Word window appears. 

Computer G3_Ch-4.indd   40Computer G3_Ch-4.indd   40 27-02-2023   10:27:1227-02-2023   10:27:12



41Chapter 4 I Introduction to  Microsoft Word 2016

COMPONENTS OF MS WORD 2016
A Word window has many parts. Let us look at these parts in detail.

Richard Brodie and Charles Simonyi developed Microsoft Word in 1983.

NEWS FEED

Document Window
A document window is the area of the screen that displays the content of the 
document or the work being done.

Title Bar
The title bar displays the name of the document and the program. It is on the 
top of the window. Every document has a temporary name. This name can be 
changed when we save the document. On the right corner of the title bar, the 
three control buttons Minimize, Maximize/Restore and Close are displayed.

Ribbon

Zoom Slider

Title bar

File tab

Rulers

Document Area
Scroll Bars

Quick Access toolbar

|
Text/ 
        (Working Area)

2

1

3
4

CM
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Quick Access Toolbar
It is present on the left corner of the title bar. It contains buttons such as Save, 
Undo and Redo which are the most frequently used commands. There is a 
button, Customize Quick Access, that allows us to select other buttons that can 
appear on the Quick Access Toolbar.

Ribbon 
The Ribbon is located below the Title bar. It contains several tabs, groups and 
commands.

File Tab
The File tab is located in the left corner below the Quick Access Toolbar. It 
contains different options such as New, Open, Save, Save As, Print, Share, 
Close, etc.

Text or Document Area
The text or document area is the working area. It is the area where text is typed, 
edited and deleted.

Cursor
A cursor is the vertical blinking line that we see in the text area. It indicates the 
position of the types of characters. 

Ruler
There are two rulers in the Word window—horizontal and vertical. The Horizontal 
ruler measures the width of the document page. The vertical ruler measures the 
height of the work area.

Scroll Bars
There are two scroll bars in the Word window—horizontal and vertical. The 
horizontal scroll bar is used to navigate the text left or right. It is located at the 
bottom of the window. The vertical scroll bar is used to navigate the text up and 
down. It is located on the right side of the window.

Status Bar
The status bar displays the page number, number of words and language. It is 
located at the bottom, below the vertical scroll bar.
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Zoom Slider
A zoom slider is used to enlarge or reduce the size of the document window. It is 
located on the right side of the status bar.

CREATE A NEW DOCUMENT
Follow these steps to create a new document:

1.	 Click on the File tab.
2.	 Click on the New option.
3.	 Click on the Blank document option.

QUICK BYTE

You can also open a new 
document using the shortcut 
keys Ctrl + N.

2

1

3

TYPE TEXT IN A DOCUMENT
The text that we type will display on the text or document area. We can enter the 
text by using the keyboard. The cursor that is displayed in the text area shows 
the position from where we can start typing. As we keep typing, the cursor also 
shifts automatically. This feature of Word is called Word Wrap. While typing 
the text, we use Spacebar to give space between words, Enter to start a new 
paragraph, and Delete and Backspace to delete text. 

SELECT TEXT IN A DOCUMENT
We can make changes to the text already entered such as copying, moving or 
deleting. To make these changes, first, we need to select the text.

Follow these steps to select text:

1.	 Place the cursor before the text to be selected.
2.	 Hold the left mouse button and drag it over the text to be selected.
3.	 Now, release the mouse. The selected text will be highlighted.

CM
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COPY TEXT IN A DOCUMENT
We can duplicate a text using copy and paste option. We can copy and paste 
text from the same document as well as from other documents. One advantage 
of this feature is that it helps in reducing time and effort in typing the same thing 
repeatedly. 

Follow these steps to copy and paste text:

1.	 Select the text to be copied. 
2.	 Click on the Copy  button in the Clipboard group on the Home tab.
3.	 Now, place the cursor on the place you want to paste. 

4.	 Click on the Paste  button in the Clipboard group on the Home tab.

5.	 The copied text appears in the new place. 

One page in Microsoft Word has 29 lines by default.

NEWS FEED

Selected text

QUICK BYTE

You can also copy text using the short cut Ctrl + C.

You can also paste text using the short cut Ctrl + V.

CM

CM
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SAVE A DOCUMENT
To use a document in future, we need to save it.

Follow these steps to create a new document:

1.	 Click on the File tab.
2.	 Click on the Save or Save As option. 
3.	 Select This PC option and click on the Browse option.
4.	 Select the location, say in the example it is Documents.
5.	 Type the name for the file in the File name box.
6.	 Click on the Save button.

Or
Click on the Save  button to save a document.

1

QUICK BYTE

You can also save a document using the short cut Ctrl + S.

OPEN A SAVED DOCUMENT
We can open a saved document if we want to make any changes or just read it.

Follow these steps to open a save 
document.

1.	 Click on the File tab.
2.	 Select the Open option
3.	 Select This PC option or the location where the file is saved.
4.	 Select the file to be opened
5.	 Click on the Open button.

1

2

3

4
5

6

CM
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PRINT A DOCUMENT
Follow these steps to take a printout of the document  
you have created:

1.	 Click on the File tab.
2.	 Click on the Print option.
3.	 Click on the Print button.

2

1
2

3

3

5

4

QUICK BYTE

You can also print a document using the short cut Ctrl + P.

CLOSE A DOCUMENT
Follow these steps to close a document  
after the work is finished:

1.	 Click on the File tab.
2.	 Click on the Close option.
	 Or
3.	 Click on the Close button on the right corner  

of the Title bar to close the document. 
We have to save a document before closing to use  
it in future. If the document is not saved or the  
changes are not saved, then Word will prompt to  
save it before closing. 

3

1

2

CM
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A dialog box with three options will appear:

•	 Click on Save to save the file or save the 
changes.

•	 Click on Don’t Save to close the 
document without saving any changes.

•	 Click on Cancel if you do not want to close the document.

Match the functions with the shortcut commands.

1. 	 To open a new document				    a. 	 Ctrl + O

2. 	 To save a document 					     b. 	 Ctrl + C

3. 	 To print a document 					     c. 	 Ctrl + N

4. 	 To copy text						      d. 	 Ctrl + S

5. 	 To open a saved document				   e. 	 Ctrl + P

ACTIVITY TIME

•	 A software on which we can create, edit and print documents is called Word 
Processor software.

•	 MS Word is an application software that we use to type text on a computer.

•	 MS Word is used to create, edit and print a text document.

•	 The components of MS Word are Application Window, Document Window, 
Title bar, Quick Access Toolbar, Ribbon, File tab, Text or Document area, 
Cursor, Ruler, Scroll bars, Status bar and Zoom Slider.

•	 Document window displays the text that is entered.

•	 A new document can be opened by clicking the New option of the File tab.

REFRESH

CRCT
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•	 A document can be saved by clicking the Save option of the File tab.

•	 A saved document can be opened by clicking the Open of the File tab.

•	 A document can be closed by clicking the Close option of the File tab.

BROWSE

A 	 Choose the correct option.

	 1. 	� It is a program that helps us to create documents such as letters.

		  a. 	 Word	 	 b. 	 Operating	 	 c. 	 Paint�
			   Processor			   system

	 2. 	 It is an application software.

		  a. 	 MS Windows 10	 		 b. 	 MS Windows 7�

		  c. 	 MS Word		

	 3. 	 It is the area where the content of the document is displayed.

		  a. 	 Title Bar	 	 b. 	 Document window	 	 c. 	 Ribbon�

	 4. 	 It displays the page number and number of words in the document.

		  a. 	 Scroll bars	 	 b. 	 Zoom slider	 	 c. 	 Status bar�

	 5. 	 It is used to enlarge or reduce the size of the document window.

		  a. 	 Status bar	 	 b. 	 Ruler	 	 c. 	 Zoom slider�

B 	 Fill in the blanks with the words given below.

	   Close button      Print      create      Save      two

	 1. 	 MS Word is used to  documents.
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	 2. 	 There are  scroll bars in MS Word.

	 3. 	 Click on �  option to save a document..

	 4. 	 Click on   option to print a document.

	 5. 	 Click on   to close a document.

C 	 Write T for true statements and F for false statements.

	 1. 	 Title bar is located at the bottom of the window.�

	 2. 	 Quick Access Toolbar contains the three control buttons.�

	 3. 	 The Spacebar is used to give space between words.�

	 4. 	� To copy text means to make a duplicate copy of the text.�

	 5. 	 We cannot make changes in a saved word file. �

D 	 Answer in one word or two words.

	 1. 	 It contains several tabs, groups and commands.�

	 2. 	� It displays the name of the document and  

the program.�

	 3. 	� It measures the height and width of the  

document page.�

	 4. 	� It indicates the position of the text or characters.�

	 5. 	� It is the area where text is typed.�
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E 	 Answer the following questions.

	 1. 	 Write five uses of MS Word.

	 2. 	� Name the six components of the MS Word window.

	 3. 	� What is document window?

	 4. 	� How would you create a new document?

	 5. 	� Write the steps to save a document.

In your notebooks, write two sentences about MS Word.

ACTIVITY TIME

In the computer lab, do this task with the help of your teacher—Create a 
Word document.

•	 Open Word.

•	 Type 10 sentences about yourself.

•	 Save the document and name it.

LET'S EXPLORE

•	 Explain the uses of MS Word.

•	 Show the students how to open MS Word program. 

•	 Explain the different components of Word window.

•	 Show them how to minimize, maximize and close a document.

•	 Show them the essential shortcuts to operate.

FOR THE TEACHER

CMCT

EL CMTE
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Introduction to Internet5

LEARNING OBJECTIVES

In this chapter, students will learn about:

What is Internet?

Uses of the Internet

Terms related to the Internet

Opening a web page

Advantages and disadvantages of the Internet

Online safety

SIGN IN

What do you use the computer for? Tick the pictures.

Scan QR Code to
watch a video

CMCT
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In the previous classes, we have learnt that we use computers to draw, write, 
watch movies, listen to music, play games, etc. We can do much more on the 
computer with the help of the Internet. 

We can play online games, send messages instantly, and watch live coverage of 
an event that is happening somewhere far. We can even talk to family members 
and friends online even if they live in different places. Let us learn about the 
Internet.

INTERNET
We see many things around us that are 
interconnected to form a network such as 
a network of roads, electricity wires, etc. A 
computer network is formed when two or more 
computers are connected to communicate, 
share resources and exchange files. 

Internet is a worldwide network that connects millions of computers. The 
networks are formed either through connected cable, telephone wires or wireless 
media. With the help of the Internet, millions of computers around the world are 
connected. Through the Internet, we can communicate and share all kinds of 
information. The Internet is also known as the ‘net’.

USES OF INTERNET
The Internet has become an important part of our lives. Using the Internet, we 
can do our work comfortably. The Internet is used for education, entertainment, 
online shopping, banking, searching for information etc. When an activity takes 
place over the Internet, it is said to be online. 

These are some of the uses of the Internet:

Communication 
One of the important benefits of the Internet is communication. It helps us stay 
connected with our friends and families in different places all over the world. 
Through the Internet, we can also connect with new people. There are many 
ways through which we communicate with each other.
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Sharing Information
The Internet is an important tool to share and get 
information. On the Internet, we can search for 
information on any topic. It provides us with the 
facility to keep us updated on various topics such 
as education, sports, music, politics, etc. 

The Internet is one of the effective tools for teaching. Both teachers and students 
can use the Internet as a source to gather information and gain knowledge on 
various topics. 

Email
Email means electronic mail. It is the electronic equivalent of 
letters. We exchange messages from one computer or electronic 
device to another computer through the Internet. It allows us 
to exchange messages instantly. Through email, we can share 
documents, pictures and videos.

Chatting
Chatting is personal communication through the Internet. When 
we chat, we exchange text messages instantly. There are many 
apps through which we chat. WhatsApp is an example of apps 
through which we chat.

Social Networking
Social networking or social media is another way 
through which we communicate and stay connected 
with other people. We can also make new friends 
through it. We also get news and updates on current 
events through social media.

Entertainment
Through the Internet, we get access to many entertainment 
sites. We can watch movies, television shows and listen to 
music on any Internet enabled device. We can also watch 
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a live event even if we are not present in the place. We can also play online video 
games.

Online shopping
These days we do not have to go to market to buy 
things. Through Internet, we can buy various items 
such as clothes, toys, books, food, etc. without going 
to the stores or market. This is called online shopping. 
This also allows us to buy things from different places 
all over the world.

Online Banking
Online banking means carrying out all the banking tasks 
through the Internet on our computer or phone. It allows 
us to do tasks such as transferring money and paying bills 
without visiting the bank.

Video Conference
Video conferencing is a live video-based meeting. It allows 
people in different locations to communicate face-to-face 
through the Internet.

DEVICES REQUIRED TO CONNECT TO THE INTERNET
•	 A modem 

•	 A telephone or a cable line

•	 A computer

•	 A company providing internet  
connection

TERMS RELATED TO THE INTERNET
Website
A website is a collection of webpages and related content that provide 
information. It has many pages like a book. Look at the given picture.  

ComputerModem Telephone
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This is the website of a school. 
This website has various 
information about the school. 
When we click on a topic we want 
to know about, say admission, 
the page related to it will open up. 

Wikipedia is one of the most 
visited websites in the world.

Wikipedia website

Webpage
A webpage is part of a website. It is a digital page that contains information 
about a single topic. The contents of a webpage may consist of text, images, 
audio, video or links to other pages.

Homepage
A homepage is the main page of a website. It contains links to other pages. 

Web Browser
We need a web browser to view a website or a webpage. 
A web browser is an application software that allows us to 
open websites. Google Chrome, Internet Explorer, Microsoft 
Edge, Mozilla Firefox, Safari and Opera are some of the 
web browsers.

A website

Clicking 
on these 
topics 
will open 
pages 
related 
to them.

Web browser

Opera SafariGoogle Chrome

Mozilla 
Firefox

Microsoft 
Edge

Internet  
Explorer
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VISITING A WEBSITE
To visit a website means to open a website and go through its contents. To open a 
website, we need to enter its URL in the address bar located on top of every web 
browser. A URL of a website is the address of the website. A URL looks like this:

https://www.google.com/

WWW means World Wide Web which is the largest collection of information on 
the Internet.

In June 2022, google.com was the most popular website in the world.

NEWS FEED

World Wide Web was invented by a computer scientist named Tim Burners-
Lee in 1989.

NEWS FEED

ADVANTAGES AND DISADVANTAGES OF THE INTERNET
We have learnt that Internet has many uses. It has made our life easy and 
comfortable. It has influenced our lives in many ways. The Internet can also 
cause problems if it is misused. Let us look at the advantages and disadvantages 
of the Internet.

Advantages

•	 Information: The Internet has information on every subject. This is one of the 
most significant advantages of the Internet. 

•	 Communication: Communication has become faster and easier because 
of the Internet. We can talk to people who are in different places instantly. 
The Internet offers different communication methods such as email, voice 
message, video chat or video conferencing, etc.

•	 Accessibility: The Internet is accessible all the time if you have a computer 
that is connected to the Internet. It never closes. So, we can access the 
information on the Internet whenever we need it.

CM

CM
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Disadvantages

•	 Addictive: The Internet can be addictive. We 
spend so much time on the Internet. For some 
people, it can become an addiction. Therefore, 
we should try to reduce our time spent on the 
Internet. 

•	 Lack of Social skills: These days people have 
reduced interaction with other people as they spend most of their time alone 
using the Internet. This has made us lose our communication and social skills.

•	 Misuse: The information that we find on the Internet can be misused. Instead 
of using it for doing a useful thing, it can be used as a distraction. Children 
spend so much time on entertainment such as playing games and watching 
videos which can affect their studies.

•	 Reliability: All the information available on the Internet is not reliable or 
genuine. It could be fake. We should always cross-check and find a reliable 
and trusted source.

ONLINE SAFETY
Online safety refers to taking precautions to stay safe online. Some of the 
precautions that we can take to be safe online are:

•	 Do not share personal information such as full name, home address, birth 
date, school name or phone number.

•	 Should be careful while meeting online friends. We should not agree to meet 
an online friend alone.

•	 Set up a strong password. It is important to have a strong password and 
should not forget to log out of your account if using a public computer such as 
in a library.

•	 Do not share your password with anyone.

A child being stopped from 
using Internet
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Match the picture with the correct activity.

1. 	   					     a. 	 Online shopping

2. 	 					     b. 	 Online banking

3. 	 					     c. 	 Chatting

4. 	 					     d. 	 Video conferencing

5. 	 					     e. 	 Social networking

ACTIVITY TIME

•	 Internet is a worldwide network that connects millions of computers.

•	 The Internet is used for education, entertainment, online shopping, banking, 
searching for information, etc.

•	 A modem, telephone or cable line, a computer and a company providing 
Internet connections are required to connect to the Internet. 

•	 A website is a collection of webpages and related content.

•	 A webpage is a digital page that contains information about a single topic.

•	 A homepage is the main page of a website.

•	 A web browser is application software that allows us to open websites.

REFRESH

CRCT
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BROWSE

A 	 Choose the correct option.

	 1. 	� WWW stands for .

		  a. 	 World Wide	 	 b. 	 Wide World	 	 c. 	 Web World�
			   Web			   Web			   Wide

	 2 	� Video conferencing is a live  meeting.

		  a. 	 video-	 	 b. 	 audio-	 	 c. 	 picture-�
			   based			   based			   based

	 3. 	� These are required to connect to the Internet.

		  a. 	 A modem and a computer	 	 b. 	 telephone or cable line�

		  c. 	 both a and b	

	 4. 	� A website has  pages.

		  a. 	 one	 	 b. 	 two	 	 c. 	 many�

	 5. 	� It is a web browser.

		  a. 	 Google	 	 b. 	 Siri	 	 c. 	 Alexa�
			   Chrome

B 	 Fill in the blanks with the words given below.

	
website      Online      Chatting      electronic      webpage

	 1. 	� Email means  mail. 

	 2. 	�   is personal communication 

through the Internet.
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	 3. 	� A  consists of text, images, audio, video 

or links to other pages.

	 4. 	� A  contains links to other pages.

	 5. 	�   safety refers to taking precautions to 

stay safe online.

C 	 Write T for true statements and F for false statements.

	 1. 	� Communication has become slower and more difficult  

because of the Internet.�

	 2. 	� A website has a single page.�

	 3. 	� A website is a part of a webpage.�

	 4. 	� Homepage is the first page of a website.�

	 5. 	� All the information available on the Internet is not reliable  

or genuine.�

D 	 Answer the following questions in one word or two words.

	 1. 	� It is also known as the net.�

	 2. 	� It contains many digital pages. �

	 3. 	� It is a program to access websites.�

	 4. 	� It is the first page of any website.�

	 5. 	� It is like an address of a website.�
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E 	 Answer the following questions.

	 1. 	� Write six uses of Internet.

	 2. 	� What is the difference between a website and a webpage?

	 3. 	� Write two advantages and two disadvantages of Internet.

	 4. 	� What is online safety? How can you stay safe online? Write two points. 

In in the computer lab, do these activities:
•	 Who is your favourite sport person? Collect information about the person 

using the Internet.

•	 Note the webpages that you visit.

•	 Ask your teacher to help you to open your school website. Then click and 
open the various webpages that are there on your school website. 

LET'S EXPLORE

Look at the pictures. Which of these are digital devices? Colour them.

ACTIVITY TIME

•	 Explain what is Internet and the uses in details.

•	 Tell the students about the disadvantages and advantages of the Internet.

•	  Explain to them how to be safe on the Internet.

FOR THE TEACHER

CRCT

ELTE
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PERIODIC ASSESSMENT 2

A.	 Identify the following web browsers and write their names.

	     					   

		  1.  			   2. 

	     					   

		  3.  			   4. 

B.	 Fill in the blanks using the words given below.

	
CHATTING    SAVE    TWO    ELECTRONIC    CLOSE BUTTON

		  1. � Click on  option to save a document in MS Word.

		  2. � There are  scroll bars in MS Word.

		  3. � Email means  mail.

		  4. � Click on  to close a document in MS Word.

		  5. �   is personal communication through the Internet.
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A.	 Choose the correct option.
		  1.  IPO stands for .
		  a.	 Input-Process-	 	 b.	 Install-Process-	 	 c.	 Insert-Process-�
			   Output			   Output			   Output

		  2.  We cannot touch a .
		  a.	 hardware	 	 b.	 software	 	 c.	 paper�

		  3.  Windows is an  system. 
		  a.	 processing	 	 b.	 executing	 	 c.	 operating�

		  4.   is the area where text is typed in MS Word.
		  a.	 Drawing area	 	 b.	 Document area	 	 c.	 Title bar�

		  5.   is like an address of a website.
		  a.	 Homepage	 	 b.	 Webpage	 	 c.	 URL�

B.	 Write (T) for true statement and (F) for false statement.
		  1.  Soft copy is an input when printed on paper.�

		  2.  Computer components can be grouped into two categories.�

		  3.  Desktop background is a part of the taskbar.�

		  4.  MS Word is a system software.�

		  5.  WWW stands for Web World Wide. �

C.	 Answer the following questions.
		  1.  What is application software? Explain with the help of examples.
		  2.  Define the parts of the CPU.
		  3.  Why do we select text in MS Word? And how?
		  4.  Name any four devices required to connect to the Internet.
		  5.  What is a desktop? Name the main components of a desktop.

63Test Paper 1
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More Features of Paint6

LEARNING OBJECTIVES

In this chapter, students will learn about:
Paint window
Select a picture
Resize a picture
Skew a picture
Flip a picture
Rotate a picture
Zoom a picture
Crop a picture
Copy and paste a picture
Save a picture
Open an existing picture

SIGN IN

Connect the dots to complete the picture and colour it.

1

2
3

4 5 6 7
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11 12
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34353638
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646566

67

Scan QR Code to
watch a video
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We have learnt in the previous classes how to draw and colour pictures using 
Paint. Paint also has other features which allow us to make changes to an 
existing picture. Let us learn about these features in this chapter.

PAINT WINDOW
Follow these steps to open Paint window:

1.	 Click on the Start button.
2.	 Scroll the list of programs and click on Window 

Accessories. A new window will appear.
3.	 Click on Paint.The Paint window appears. 

Paint window

A Paint window has many components such as Tools, Shapes, Colors, etc. These 
components help us to draw and colour beautiful pictures. Let us recall some of 
these components you have learnt in the previous class.

TOOLS
Pencil Tool : It is used for freehand drawing.	

Fill with color Tool : It is used to fill colours.

Text Tool : It is used to enter text.

Eraser Tool : It is used to remove or erase text or shapes.

2

3

1
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SHAPES
Line Shape : It is used to draw lines.

Curve Shape : It is used to draw curved lines.

Oval Shape : It is used to draw ovals or circles.

Rectangle Shape : It is used to draw rectangles or squares.

Rounded Rectangle Shape : It is used to draw rounded rectangles or squares.

Polygon Shape : It is used to draw closed figures.

MODIFY A PICTURE
After a picture is drawn, we can modify the picture. Paint has many features that 
allow us to modify a picture, i.e., copy, delete or move whole or part of the picture. 
We can also resize, rotate, crop or select a picture or a part of it. These options 
are available in Clipboard and Image group on the Home tab. Let us learn more 
of these features of Paint in detail.

SELECT A PICTURE
We can select and change any part of a picture. The Select tool  present in 
the Image group on the Home tab is used to  
select any part of the picture. 

Follow these steps to a part of a picture:

1.	 Click on the Select tool. It will provide two 
types of selection tools.

2.	 Click on the Rectangular Selection tool   
to select the picture in a rectangular shape. 
To select a picture, place the pointer just  
outside the area to be selected. Then, click 
and drag the pointer over the area to be 
selected. Release the mouse when the area  
to be selected is complete. 

3.	 Click on the Free-form selection tool  to 
select a part of a picture in an irregular shape. 

1

2

3
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RESIZE A PICTURE
To resize a picture means to change 
the size of the picture. The size 
can be increased or decreased. 
A picture can be resized by using 
Resize command.

Follow these steps to resize a 
picture:

1.	 Click on the Select tool to select 
the picture.

2.	 Click on the Rectangular Selection. Drag the mouse over the picture to  
select it. 

3.	 Click on Resize. Resize and skew box appears.
4.	 In the Resize section, enter the Horizontal value and Vertical value.
5.	 Select the Maintain aspect ratio.
6.	 Click OK.

	

SKEW A PICTURE
To skew a picture means to turn the picture at an angle. A picture can be skewed 
by stretching from one end and keeping the other end fixed.

1

2

3

4

5

6
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Follow these steps to skew a picture:

1.	 Click on the Select tool to select the 
picture.

2.	 Click on the Rectangular Selection. 
Drag the mouse over the picture to 
select it. 

3.	 Click on Resize. Resize and skew 
box appears.

4.	 In the Skew section, enter the value either in the Horizontal or Vertical boxes.
5.	 Click OK.

The skewed picture

ROTATE A PICTURE
To rotate a picture means to turn or change the angle of the picture. We can 
rotate a picture by using the rotate command. 

Follow these steps to rotate a picture:

1.	 Click on the Select tool to select the 
picture.

2.	 Click on the Rectangular Selection. 
Drag the mouse over the picture to 
select it. 

3.	 Click on Rotate. There will be three 
options to rotate.

1

2
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4.	 Click on the rotation direction and the angle you want to rotate the picture. 
Here, it is clicked on Rotate right 90.

	 The picture will be rotated by 90 to the right.

	 The rotated picture

3 4

FLIP A PICTURE
To flip a picture means to turn or rotate a picture horizontally or vertically. 

Follow these steps to flip a picture:

1.	 Click on the Select tool.
2.	 Click on the Rectangular Selection. Drag  

the mouse over the picture to select it. 
3.	 Click on Rotate. There will be two options to flip.
4.	 Click on the direction of flip you want to flip  

the picture. Here, it is clicked on Flip vertically. 
	 The picture will be flipped vertically.

	 The flipped picture

3

4

1
2
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CROP A PICTURE
To crop a picture means to delete or remove everything outside the selected 
portion. Only the selected section of the picture will be available after cropping.

Follow these steps to crop a picture:

1.	 Click on the Select tool.
2.	 Drag the mouse over the picture to select it. 
3.	 Click on Crop. Only the selected part of the picture remains in the drawing 

area.

The cropped picture

1

2

3

CUT AND PASTE
To cut and paste means to cut a picture or a 
part of it and paste it to a different place. 

Follow these steps to cut and paste a picture:

1.	 Click on the Select tool.
2.	 Drag the mouse over the part of the 

picture you want to select. 
3.	 Click on Cut. The selected part of the 

picture will disappear from the drawing 
area. 

4.	 Now, click on Paste. The cut part of the 
picture will appear in the drawing area.

Cut and paste part of the image

4

3

1

2
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COPY AND PASTE
To copy and paste means to make a duplicate copy of the picture. 

Follow these steps to copy and paste a picture:

1.	 Click on the Select tool.
2.	 Drag the mouse over the picture to select it. 
3.	 Click on Copy. 
4.	 Now, click on Paste. A duplicate picture will appear on the top left corner of 

the drawing area.

	 The duplicate picture

3
1

2

ZOOM A PICTURE
To zoom in and zoom out means to make the 
view size bigger or smaller on the screen. 

Follow these steps to zoom a picture:

1.	 Click on the View tab.
2.	 Click on Zoom in  to increase the view 

size. The picture will appear larger and 
nearer.

3.	 Click on Zoom out  to decrease the view 
size. The picture will appear smaller and 
further away.
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SAVE A PICTURE
To save a picture means to keep it for further use. If we save a picture, we can 
use it again or make changes to it.

Follow these steps to save a picture:

1.	 Click on the File tab.
2.	 Click on Save or Save As option. The Save As box will appear.
3.	 Type the name you want for the picture in the File name box.
4.	 Click on Save. 

	

OPEN AN EXISTING PICTURE	
Follow these steps to open an existing picture:

1.	 Click on the File tab.
2.	 Click on the Open option. 
3.	 Type or select the name of the picture you want to open in the File name box.
4.	 Click on Open. The picture will open.

	

1

2

1

2

3

4

3

4
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TO SET A PICTURE AS THE DESKTOP BACKGROUND
The picture you have created can be set as your desktop background. 

Follow these steps to set the picture created as a desktop background.

1.	 Click on the File tab.
2.	 Click on the Set as desktop background option. Three options will appear on 

the right side.
3.	 Select and click on any of the three options.

The first version of MS Paint, named ‘Windows Paint’, was developed by Dan 
McCabe in the year 1985.

NEWS FEED

1

2

3

CM
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Look at the picture and write the name the command(s) used to draw each 
object in Paint. Use the help box to find the right command.

	

Rectangle, line and curve			  Curve and pencil
  Rectangle, line and oval			   Oval

1. 	 House 

2. 	 Sun  

3. 	 Trees   

4. 	 Boats 

ACTIVITY TIME
CMCRCT
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•	 Paint is aprogram used for drawing and colouring.

•	 Paint has many features that help us to modify a picture.

•	 Resize means to change the size of a picture.

•	 Skew means to turn or place the picture at an angle. 

•	 Rotate means to turn or change the angle of a picture.

•	 Flip means to turn or rotate a picture horizontally or vertically. 

•	 Crop means to delete or remove everything outside the selected portion.

•	 Cut and paste mean to cut a picture or a part of it and paste it to a 
different place.

REFRESH

BROWSE

A 	 Choose the correct option.

	 1. 	� To select a picture, click on . 

		  a. 	 Select	 	 b. 	 Paste	 	 c. 	 Copy�

	 2. 	� To resize a picture, click on . 

		  a. 	 Rotate	 	 b. 	 Resize	 	 c. 	 Crop�

	 3. 	� To flip a picture, click on .

		  a. 	 Crop	 	 b. 	 Rotate	 	 c. 	 Resize�

	 4. 	� To cut a picture or a part of it, click on .

		  a. 	 Paste	 	 b. 	 Copy	 	 c. 	 Cut�
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	 5. 	� To zoom a picture, click on .

		  a. 	 File	 	 b. 	 Home	 	 c. 	 View�

B 	 Fill in the blanks with the words given below.

	
open    Cut    Paint    name    file    Skew    paste

	 1. 	�   is a program used for drawing and colouring.

	 2. 	�   means to turn or place the picture at an angle.

	 3. 	� The  of a file is typed in the File name box.

	 4. 	�   and  means to cut a 

picture or a part of it and paste it to a different place.

	 5. 	� To open a picture, click on  option in the 

 tab.

C 	 Write T for true statements and F for false statements.

	 1. 	� To start Paint, the first step is to click on the Start button.�

	 2. 	� Select tool provides two types of selection.�

	 3. 	� Resize means to change the angle of a picture.�

	 4. 	� Only the selected section of a picture is available after cropping.�

	 5. 	� Zoom out makes the picture appear smaller. �
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D 	 Answer in one word or two words.

	 1. 	� It is used to enter text.�

	 2. 	� It is used to select irregular part of a picture.�

	 3. 	� It is used to make the picture appear larger  
and nearer.�

	 4. 	� It is used to draw circles.�

	 5. 	� It is used to skew a picture.�

E 	 Answer the following questions.

	 1. 	� How do you modify a picture?

	 2. 	� Write the steps to rotate a picture.

	 3. 	� Write the steps to crop a picture.

	 4. 	� How do you save a picture? 

	 5. 	� Write the steps to set a picture as desktop background.

Read the clues and complete the crossword puzzle.

Across 
1.	 To keep it for further use
3.	 To turn or change the angle 

of a picture
4.	 to turn and rotate a picture 

horizontally or vertically

1

2

3

4

ACTIVITY TIME
PL
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Down 
1.	 to turn a picture at an angle
2.	 to delete or remove selected portion of a picture

Do this activity in the computer lab.

Open Paint and draw the picture given here.

Now, modify the picture.

•	 Resize the picture. Make it smaller.

•	 Skew the picture.

•	 Flip the picture vertically.

•	 Rotate 180°.

LET'S EXPLORE

•	 Explain different parts of the Paint screen and their functions.

•	 Explain how to open and choose tools for drawing, making changes,  
saving, etc. 

•	 Explain the different between Cut and Copy, Rotate and Flip command. 

FOR THE TEACHER

EL CRTE
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Introduction to Logo7

LEARNING OBJECTIVES

In this chapter, students will learn about:

MSW Logo—An Introduction

Starting Logo

Logo terms

Parts of MSW Logo window

Logo Commands

Exiting Logo

SIGN IN

Match the following.

1. 	 					     a. 	 The girl is going left

2. 	 					     b. 	 The boy is going right

3. 	 					     c. 	 The girl is going forward

4. 	 					     d. 	 The boy is going backward

Scan QR Code to
watch a video

CRCT
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A computer is a machine that needs instructions and data to function. The 
instruction given to the computer is processed and the required output is 
produced. The set of instructions given to the computer to perform a task is 
called a program. The process of writing instruction or commands for the 
computer is called programming. 

Just like humans need language to communicate, computers also need a 
language that they can understand. There are many programming languages 
that are used to give instructions to the computer. The logo is one such language. 
Let us learn about Logo in this chapter.

MSW LOGO—AN INTRODUCTION 
MSW Logo commonly known as LOGO stands for Logic Oriented Graphic 
Oriented. It is one of the simplest and easiest computer languages. It is designed 
to teach programming to children. We can use Logo to draw pictures, type text 
and do calculations. 

Logo was designed by Seymour Papert in 1967.

STARTING LOGO
To open MSW Logo, follow these 
steps:

1.	 Click on the Start button. Then, 
scroll through the alphabetical 
list of programs to find Microsoft 
Windows Logo.

2.	 Click on the Microsoft Windows 
Logo folder.

3.	 Click on Microsoft Windows Logo. The MSW Logo window will appear. 

LOGO TERMS

Turtle
Turtle is a small triangle that is seen at the centre of the Logo screen. It is used as 
a pen to draw figures on the screen.

1

2

3
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The turtle has two parts.

•	 Head: The pointed top of the turtle

•	 Tail: The base at the bottom of the turtle
We can draw figures by moving the turtle. It moves on the 
screen according to the commands and leaves behind a line. 
This line draws a figure like a pen does. The central position 
where the turtle lives is called the home of the turtle. The turtle can move in two 
directions: Forward and Backward.

Primitives
The logo commands are called primitives. The primitives instruct the turtle what 
to draw on the screen. Commands are run by pressing the Enter key or clicking 
the Execute button.

PARTS OF MSWLOGO WINDOW
The MSW logo window has two main parts: Main screen and Commander Window.

Main Screen

MSW Logo Window

Commander 
Window

Turtle

Main Screen
The main screen is the blank area in the middle of the window. This is the work 
area where we see the picture we draw.

Commander Window
The area under the main screen is the commander window. This is used for 
typing commands. It is divided into three sections.

Head

Tail
Turtle
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1.	 Input Box
	 This is the white bar where we enter all the commands. We can run the 

commands by pressing the Enter key or by clicking the Execute button.
2.	 Recall List Box
	 This is the grey area that shows all the commands that are entered into 

the Input box. It also displays the messages related to the results of these 
commands.

3.	 Control Button
	 The command window has eight buttons. Each button has a specific task. 

These are some of the buttons:

•	 Execute: To run or execute the commands.

•	 Reset: To clear the main screen.

•	 Halt: To stop the command from getting executed.

•	 Status: To display a status window of the current settings.

LOGO COMMANDS
Forward Command
Forward command moves the turtle forward in the direction in which it is pointing, 
i.e., in the direction of its head. The short form of Forward command is FD.

The Forward command is given as:

1.	 Type FD.

Main Screen

Recall List Box Control Buttons

Commander Window
Input Box
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2.	 Press the Spacebar key.
3.	 Type the number of steps.
4.	 Click Execute button or press the Enter key.

Let us look at this example.

In Fig. 1, the command entered is

		  FD <space>30

In Fig. 2, the command is displayed as FD 30 on the 
Command Input Box and the turtle moves 30 steps 
ahead on the screen.

Back Command
Back command moves the turtle forward in the 
direction opposite to which it is pointing, i.e., in 
the direction of its tail. The short form of Back 
command is BK.

The Forward command is given as:

1.	 Type BK.
2.	 Press the Spacebar key.
3.	 Type the number of steps.
4.	 Click Execute button or press the Enter key.

In Fig. 3, the command given is 

	 BK <space> 30

The command is displayed as BK 30 on the 
Command Input Box and the turtle moves 30 
steps back on the screen.

Right Command
Right command turns the head of the turtle 
towards the right side, i.e., in the clockwise 
direction. It rotates without changing its position. Fig. 3 The turtle moving backwards

Fig. 1 Giving command

Fig. 2 The turtle moving forward
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It needs to know the angle at which it will rotate. The 
short form of Right command is RT.

The right command is given as:

1.	 Type RT 90 (90 is the angle at which the turtle 
will rotate.)

2.	 Click Execute or press Enter. The head of the 
turtle turns by 90 turns to the right.

In Fig. 4, the command is 

RT <space> 90

Left Command
Left command turns the head of the turtle towards 
the left side, i.e., in the anti-clockwise direction. The 
short form of Left command is LT.

The right command is given as:

1.	 Type LT 90 (90 is the angle at which the turtle will 
rotate.)

2.	 Click Execute or press Enter. The head of the 
turtle turns by 90 turns to the right.

In Fig. 5, the command is 

LT <space> 90

Clearscreen Command
Clearscreen command cleans the picture on the screen. It brings the turtle back 
to the starting point, i.e., the center of the screen. The short form of Clearscreen is 
CS. The Clearscreen command is given as: CS

As we can see in Fig. 7, the turtle is back at the center and the picture formed 
earlier is deleted.

Fig. 5

Fig. 4

Robot Turtles is a fun board game which uses the basics of Logo. 

NEWS FEED
CM
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Fig. 6 Fig. 7

Cleartext Command
Cleartext command clears all the text in the Recall list box and the command in 
the Input box. The short form of Cleartext is CT. The command is given as: CT

We can see in Fig. 10 that the text has been cleared from the Recall list and the 
Input box without deleting the picture formed in Fig. 8.

Fig. 8 Fig. 9 Fig. 10

Hide turtle Command
Hide turtle command hides the turtle. It helps us to see 
the drawing more clearly without the turtle. The short 
form of Hide turtle command is HT. The command is 
given as: HT

In Fig. 11, the turtle is not visible. We can see only the 
drawing on the screen.

Fig. 11
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Show turtle Command
Show turtle command makes the turtle reappear after 
disappearing from the command HT. The short form  
of Show turtle command is ST. The command is given  
as: ST

In Fig. 12, the turtle reappears.

Home Command 
Home command brings the turtle back to the center 
of the screen, i.e., the home position. The turtle draws a 
line when it comes back from its current position. The 
command is given as: Home

We can see in Fig. 13 that the turtle comes back to the 
center drawing from its current position drawing a line.

PRINT COMMAND
Print Command displays messages in the Commander 
window. It is used to print a text on the screen. The 
short form of Print command is PR. The message should be enclosed in square 
brackets [ ]. The Print command is given as:

PRINT <space> [your message] <Click Execute or pres Enter>

Or

PR <space> [your message] <Click Execute or pres Enter>

In Fig. 14, the commands are: 

PRINT [Hello everyone!]

PR [Hello everyone!]

The messages are displayed as:

Hello everyone!

Hello everyone!

Fig. 13

Fig. 12

Fig. 14
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EXITING MSW LOGO
We can close MSW Logo in two ways. 

Method 1
Follow these steps to exit MSW Logo:

1.	 Click on File Menu.
2.	 Click on Exit. The window will close. 

Method 2
Follow these steps to exit  
MSW Logo:

1.	 Type Bye in the Input Box.
2.	 Click Execute. The window  

will close.

There are online sites that help children to learn Logo with a web browser 
such as Turtle Academy. 

NEWS FEED

Fig. 15

2

1

Fig. 16

1 2

Match the drawing instruction with the correct Logo command.

1. 	� To show the turtle							       a. 	 HT

2. 	� To move the turtle forward						      b. 	 CT

3. 	� To hide the turtle.							       c. 	 BK

4. 	� To move the turtle in the backward direction.			  d. 	 ST

5. 	� To clear text.								        e. 	 FD

ACTIVITY TIME
CRCT

CM
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•	 LOGO is a computer language which stands for Logic Oriented Graphic 
Oriented.

•	 Logo is used to draw pictures, do calculations and print the text.

•	 The turtle is a small triangle that obeys Logo command. 

•	 The turtle has two parts—Head and Tail.

•	 The instructions given to the turtle are called primitives. 

•	 The Logo window is divided into two parts—Main Screen and Commander 
Window.

•	 The main screen is the blank area in the middle of the window.

•	 The area under the main screen where we enter commands is the 
commander window.

•	 Commander window is divided into three sections—Input box, Recall List Box 
and Control buttons.

REFRESH

BROWSE

A 	 Choose the correct option.

	 1. 	� LOGO stands for .

		  a. 	 Logical Oriented Graphic Oriented	

		  b. 	 Logical Oriented Graphical Oriented	

		  c. 	 Logic Oriented Graphic Oriented 	

	 2. 	� The Turtle is in the shape of a .

		  a. 	 Triangle	 	 b. 	 Rectangle	 	 c. 	 Oval�
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	 3. 	� BK command moves the turtle .

		  a. 	 Back	 	 b. 	 Forward	 	 c. 	 Left�

	 4. 	� This is the position of the turtle for the command LT 90.

		  a. 	 	 	 b. 	 	 	 c. 	 �

	 5. 	� The Logo command to move the turtle forward by 90 steps is

		  a. 	 FD 90	 	 b. 	 BK 90	 	 c. 	 RT 90�

B 	 Fill in the blanks with the words given below.

	   execute      CT      HT      Commander      RT      LT

	 1. 	  window is used for typing commands.

	 2. 	� We click on  to run a command.

	 3. 	�   and  commands turn the 

turtle in different direction.

	 4. 	  command clears the text in recall list box area.

	 5. 	  hides the turtle.

C 	 Write T for true statements and F for false statements.

	 1. 	� The turtle has three parts.�

	 2. 	� The Logo window is divided into two parts.�
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	 3. 	� Main screen of logo window is the area where the turtle lives.�

	 4. 	� All the Logo commands require a number with them.�

	 5. 	� CS command is used to clear the screen.�

D 	 Answer in one word or two words.

	 1. 	� This command moves the turtle forward.�

	 2. 	� This command moves the turtle towards the left side.�

	 3. 	� This command moves the turtle towards the right side.�

	 4. 	� This command takes the turtle home.�

	 5. 	� This command displays messages in the  

Commander window.�

E 	 Answer the following questions.

	 1. 	� What is a turtle? Name its parts.

	 2. 	� Define the parts of a Logo window.

	 3. 	� What are primitives? Name six Logo commands.

	 4. 	� What is the difference between Left command and Right 

command?

	 5. 	� What is Show turtle Command? How do you give this command?
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•	 Explain in details how to give the Logo command.

•	 Show them how make simple shapes using logo command.

FOR THE TEACHER

Go to the computer lab and do these activities.
Using Logo command, draw the following figures.

	

50 50

140

140

9090

90

90

LET'S EXPLORE

Label the different parts of Logo Screen.

ACTIVITY TIME
CMCT

ELCT
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PERIODIC ASSESSMENT 3

A.	 Identify the following MS Paint tools and write their names.

	 	   								      

		  1.  			   2. 

	 	   								      

		  3.  			   4. 

B.	 Fill in the blanks using the words given below.

	
COMMANDER      SKEW      PAINT      HT        EXECUTE

		  1. �   means to turn or place the pictures at an angle.

		  2. � We click on  to run a command.

		  3. �   command hides the turtle.

		  4. �   is a program used for drawing and coloring.

		  5. �   window is used for typing commands.
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Introduction to File Management8

LEARNING OBJECTIVES

In this chapter, students will learn about:

What is a file?

Create a file 

Save a file

Folder

Create a folder

Open a file or folder

Rename a file or folder

SIGN IN

Look at the pictures. Drag and keep them at the proper place.

Scan QR Code to
watch a video

CRCT
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All the things have different places to keep. What happens when we do not keep 
our things in a proper place? It will create chaos and will be difficult to find when 
we need them.  We organize and keep things in such a way that we can easily 
and quickly find them when we need them.

We have learnt that computers can store large amounts of information. We can 
also quickly find this information when we need them.  Have you wondered how 
a computer stores this information? In a computer, any information is saved or 
stored in the form of a file.

WHAT IS A FILE?
A file is a storage container on a computer that 
stores data, information or commands. It can be a 
document, image or software. 

A file is given a specific name. This name helps us 
to find it easily when we want to access it later on. 
It also gives an idea about the content of the file.  
Related files can be stored together and put in a 
folder.  It is important to name and organize the 
files on a computer. This will make it easy for us to 
find the information we want.  

CREATE A FILE
A file is created commonly using application software such as Microsoft Word, 
Paint, etc. Let us create a file in Microsoft Word.

Follow these steps to create a file in Microsoft Word:

1.	 Click on the Start button. Then, scroll through the list of programs and select 
Microsoft Office.

2.	 Now, click on Word. A new window will appear.
3.	 Click on New.
4.	 Then click on Blank document. A new blank page is displayed on the screen.  
5.	 Type text such as anything about yourself on the blank page.
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SAVE A FILE
A file needs to be saved. If we do not save a 
file before we close the application, we will 
lose the information or text entered. Saving a 
file also enables to make changes when it is 
required. 

To save a file, follow these steps:

1.	 Click on File.
2.	 Click on the Save option.  
3.	 The Save As dialogue box appears.
4.	 Choose the location, click on any drive on the left side of the window. 
5.	 Type the name of the file in the File name text box.
6.	 Click on the Save button.

1

2

3

4

Blank document

Typed text
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FOLDER
A folder is a storage location. It helps in organizing a large number of files 
present in a computer. It contains related files. It can also contain folders. A folder 
inside a folder is called a sub-folder. 

The icon for a file is similar to that of the program that opens the file. The icon for 
a folder looks like a physical folder.

A file A folder

A folder has a specific name. Two folders of the same name cannot be stored 
together at the same location. If the location is different, two folders can have 
the same name. 
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CREATE A FOLDER
On the desktop
Follow these steps to create a folder on the desktop:

1.	 Right-click on the blank area of the  
desktop. A list of options appears.

2.	 Keep the pointer on the New option. A list 
of sub-options appears.

3.	 Click on the Folder option. A new folder 
icon will be displayed on the desktop. 
It has its default name ‘New folder’ 
highlighted. 

4.	 Name the folder. Type the name at the 
cursor position and press enter.

5.	 A new folder is created.

	

54

On a drive
We can create a folder inside a drive 
using Windows Explorer.

Follow these steps to create a drive on  
a drive:

1.	 Click on the Start button. 
2.	 Scroll and click on Windows System
3.	 Click on File Explorer. 
4.	 Select a drive where you want to 

create a folder.

1

32

3

1

2
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5.	� Click on the New Folder button on 
the Home tab. (Or right-click on a 
blank area of the window. Then, 
point to new and then click on New 
folder.)

6.	 A new folder with its default name 
will appear. Name the folder.

OPEN A FILE OR FOLDER
Follow these steps to open a file or a folder:

1.	 For a file or folder on the Desktop, move the pointer to the file or folder and 
double-click on it. 

2.	 For a file in other locations, double-click on the Computer icon to open 
Windows Explorer.

3.	 Then, select the drive from the left panel and double-click on the required 
folder.

RENAME A FILE OR FOLDER
We can change the name of an existing file or a 
folder. To rename means changing the name of 
an existing file or folder.

To rename a file or a folder, follow these steps:

1.	 Right-click on the file or folder you want to 
rename.

2.	 Click on the Rename option from the Shortcut 
menu.

3.	 The file or folder name will be highlighted.
4.	 Type the new name for the file/folder on the 

textbox.

Files and folders are stored in storage devices.

NEWS FEED

4

5

6

CM
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Extensions in the file names tell us what the file contains.  For example, docx 
and doc file extensions are used for Word document.

NEWS FEED

Use the help box and write the correct names. 

File name extension      Folder      File

1. 	 			 

2. 	 docx or doc 		

3. 	 			 

ACTIVITY TIME

•	 Any information is saved or stored in the form of a file on a computer.

•	 A file is a storage container on a computer that stores data, information or 
commands.

•	 A file is created commonly using application software such as Microsoft 
Word, Paint, etc.

•	 A folder helps in organizing a large number of files present on a computer.

•	 Every file has a specific name.

•	 Two folders of the same name cannot be stored at the same location.

•	 Existing files and folders can be renamed.

REFRESH

CM

CMCT
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100 Chapter 8 I Introduction to File Management

BROWSE

A 	 Choose the correct answer.

	 1. 	� In a computer, information is stored in the form of .

		  a. 	 File	 	 b. 	 software	 	 c. 	 MS Word�

	 2. 	� It is a storage container on a computer that stores data, information 

or commands.

		  a. 	 Files	 	 b. 	 Folder	 	 c. 	 File and folder�

	 3. 	� It is a collection of related files.

		  a. 	 Files	 	 b. 	 Folder	 	 c. 	 File and folder�

	 4. 	� A file can be created using this program.

		  a. 	 MS Word	 	 b. 	 Paint	 	 c. 	 Both a and b�

	 5. 	� We get the Rename option from the shortcut menu when we 

 on a folder.

		  a. 	 Click	 	 b. 	 Right-click	 	 c. 	 Double-click�

B 	 Fill in the blanks with the words given below.

	 file    Renaming    open    name    Microsoft Word

	 1. 	� A  can also be stored inside a folder.

	 2. 	� Every folder has a specific .

	 3. 	� To create a Word file, we have to click on Start button and then 

select .
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101Chapter 8 I Introduction to File Management

	 4. 	  means to change the name of a file.

	 5. 	� Double-click on a folder to  it.

C 	 Write T for true statements and F for false statements.

	 1. 	� Two folders of the same name can be stored at the same location.�

	 2. 	� Existing file can be renamed.	�

	 3. 	� A folder can contain only files.	�

	 4. 	� Right-click on a file gives the Rename option.	�

	 5. 	� A folder can be stored in a file.�

D 	 Answer in one word or two words.

	 1. 	� A storage container that stores data.�

	 2. 	� Place to type the new name while renaming a file.�

	 3. 	� Double-click on this icon to open Windows Explorer.�

	 4. 	� Default name of a new folder.�

	 5. 	� A folder within a folder.�

E 	 Answer the following questions.

	 1. 	� What is the difference between a file and a folder?

	 2. 	� How do you create a new folder on the desktop?

	 3. 	� How do you create a new folder inside a drive using Windows Explorer?

	 4. 	� How do you open a file or a folder?

	 5. 	� How do you rename a folder?
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102 Chapter 8 I Introduction to File Management

Find the following words related to file and folder in the word search. 

Create      Folder      Rename      Document
Location      Storage      File      Organizing

W D L Y S T O R A G E N

L O C A T I O N Q L G W

Q M J I F I L E K J G B

M D P B D C R E A T E Y

R E N A M E V U N Q F H

O R G A N I Z I N G J T

C I Y M G F O L D E R B

D O C U M E N T J R T Z

ACTIVITY TIME

•	 Make the students understand the concept of organizing things giving  
real-life examples such as how we keep our clothes, books and shoes 
separately. 

•	 Show them how books are catalogued and organized in libraries to make 
them understand the concept of file and folder.

FOR THE TEACHER

Do the activity in the computer lab. Ask for help if you do not remember  
the steps. 

1.	 Create a Word document file. Save the file.
2.	 Now create a folder. Name it.
3.	 Next, rename both the folder and the file.

LET'S EXPLORE

PL

ELTE
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103Chapter 9 I More on AI

More on AI9

LEARNING OBJECTIVES

In this chapter, students will learn about:

Smartphone

Smartwatch

Smart TV

Smart Locks

Smart Speaker

Chabot

Self-driving Car

SIGN IN

There are robots that can do different things. What kind of work will you 
make the robot do if you have a chance to build it? Choose from the  
statements given below.

1. 	 Do your assignments�

2. 	 Study for you�

3. 	 Clean your room�

4. 	 Help your parents doing chores�

5. 	 Go to park with you�

6. 	 Play with you�

7. 	 Make food for you�

8. 	 Go to school with you�

9. 	 Carry your books�

Scan QR Code to
watch a video

CM CRCT

Computer G3_Ch-9.indd   103Computer G3_Ch-9.indd   103 27-02-2023   10:51:4727-02-2023   10:51:47



104 Chapter 9 I More on AI

What else do you want the robot to do? Tell your friends.

Artificial Intelligence (AI) is the method by which a computer is able to think, 
understand and learn from the data. Artificial machines are built to remember 
the behaviour of a person or how the surrounding is and adapt their responses 
to this information. 

We are surrounded by AI. It is used in many fields such as manufacturing, 
transportation, education, etc. We have learnt in the previous class some of the 
uses of AI in our daily life.  Let us learn more about AI devices.

SMARTPHONE
Smartphone has become an important part of our lives. 
It has many features and applications that help us to do 
many activities in our life easily and faster. Many of these 
applications are integrated with AI.

Navigation
AI helps us to travel in a more convenient way. 
We can use Google or Apple maps on our phones 
and type in our destination. It not only tells us the 
directions but also the optimal route and traffic 
updates. We do not have to rely on a hard copy of 
a map for directions. 

Facial recognition
Facial recognition application has become very common 
in most phones. It is used to unlock phones on some 
smartphones. It a software that analyses our facial 
features and checks if it matches the data it has. If it 
matches, the phone unlocks.

Google Maps was first launched for desktop on February 8, 2005.

NEWS FEED
CM
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105Chapter 9 I More on AI

Virtual Assistant
Most smartphones have AI-enabled virtual 
assistants such as Siri, Cortona, Google Assistant 
and Alexa. Through these virtual assistants, we can 
operate our phones through voice commands.

Smart Input
Have you ever wondered how a phone or a computer 
auto-corrects a misspelt word? This is because of AI. 
When we type text, AI predicts words and phrases. It gives 
suggestions more relevant to the context. It helps us to 
complete the typing with a simple swipe across the screen. 
This has made typing text easy and comfortable.

SMARTWATCH
A smartwatch is like a small phone or a computer that 
is worn on the wrist. Like any other normal watch, it 
tells us the time. It also has many features that make it 
a smartwatch. It is usually connected to a smartphone 
and gets notifications on incoming calls and messages. 
A smartwatch is operated through a touch screen. Most 
smartwatches come with apps that monitor heart rate and 
count the number of steps a person has taken in a day. 

SMART TV
A smart TV is a TV that can be connected to the Internet and 
allows us to access online content through the TV. It can be 
operated through a virtual assistant which makes it easy and 
convenient to use. 

Apple introduced the facial recognition system, Face ID, in 2017. 

NEWS FEED

Suggested text as we 
type the message

SiriGoogle Assistant

A smart TV

CM
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SMARTS LOCKS
A smart lock uses AI technology to lock a house. It 
is connected to a smartphone and it can detect if 
someone tries to break the lock. It uses a digital key 
instead of a physical key to lock the door. 

SMART SPEAKER
A smart speaker is a wireless speaker with an integrated virtual assistant that 
can respond to voice commands. The virtual assistant offers interactive actions 
and hand-free activation. Smart speakers are usually connected by Wi-Fi. These 
speakers can be controlled from a distance using our voice. These can be used 
for entertainment answering questions, searching the web and many other 
things. These speakers not only play music but can tell us 
about news updates, weather, and create a shopping list.

The first smart speaker is Amazon Echo. It was released 
in 2014. The voice assistant integrated with Echo is 
Amazon’s virtual assistant Alexa. We can activate this 
speaker by calling ‘Alexa’.

CHATBOT
A chatbot is a software that stimulates and 
processes human conversation. It interacts 
with the human through text messages on 
chat. They communicate with humans like a 
real person.

SELF-DRIVING CARS
A self-driving car can drive by itself. It is 
also known as a driverless car. A self-
driving car can travel without the driver 
controlling all the movement of the car. 
It can understand the surroundings and 
can navigate without the help of a human 
driver.

Amazon Echo

Chat between a man and chatbot

A self-driving car
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107Chapter 9 I More on AI

Match the pictures with the correct functions. 

1. 	 						      a. 	 Voice assistant

2. 	 					     b. 	 Facial recognition

3. 	
Suggested text as we 

type the message

						      c. 	 Navigation

4. 	 						      d. 	 Smart input

ACTIVITY TIME

•	 AI is used in many fields such as manufacturing, transportation,  
education, etc.  

•	 A smartphone has many features and applications that help us to do many 
activities in our life easily and faster.

•	 AI helps us to travel in a more convenient way.

•	 Facial recognition application is used to unlock some smartphones.

•	 Some of the devices that use AI technology are smart locks, smart 
speakers, smart TVs, smartphones, smartwatches, etc.

REFRESH

CRCT
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BROWSE

A 	 Choose the correct answer.

	 1. 	� It is the first smart speaker.

		  a. 	 Amazon	 	 b. 	 Amazon	 	 c.   Amazon�
			   Alexa			   Echo

	 2. 	� Self-driving car is also known as  car.

		  a. 	 driverless	 	 b. 	 Drivers	 	 c. 	 Non-driver�

	 3. 	� It is like a small phone or a computer that is worn on the wrist.

		  a. 	 Smartwatch	 	 b. 	 Smart Lock	 	 c. 	 Smart Tv�

	 4. 	� It can lock a door without a physical key.

		  a. 	 Smartphones	 	 b. 	 Smartwatch	 	 c. 	 Smart Locks�

	 5. 	� A TV that can be connected to the Internet.

		  a. 	 Smart TV	 	 b. 	 Smart Lock	 	 c. 	 Smartphone�

B 	 Fill in the blanks with the words given below.

	 chatbot    Amazon Echo    digital    online    touch screen

	 1. 	� A  interacts with the humans like a  

real person.

	 2. 	� A smartwatch is operated through a .

	 3. 	� We can access  content on a smart TV 

when connected to the Internet.
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109Chapter 9 I More on AI

	 4. 	� A Smart lock uses  key to lock a door.

	 5. 	� The first smart speaker is .

C 	 Write T for true statements and F for false statements.

	 1. 	� A smart speaker can understand human language.�

	 2. 	� Google Maps is AI based navigation assistant.�

	 3. 	� A smartwatch cannot be connected to a smartphone.�

	 4. 	� A smart TV can be connected to the Internet.�

	 5. 	� A smart lock uses a physical key to lock a door.�

D 	 Answer the following questions in one word or two words.

	 1. 	� It tells you which way to go.�

	 2. 	� A feature that recognizes our face.�

	 3. 	� A feature that understands our speech.�

	 4. 	� A speaker that can operates through our voice.�

	 5. 	� A car that drives without a man.�

E 	 Answer the following questions.

	 1. 	� Give two examples of uses of AI at home.
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110 Chapter 9 I More on AI

Make a list of devices you have used that are based on AI.

Then, discuss these questions with your friends:

•	 How these applications have helped you?

•	 How would you feel if these devices were not there?

•	 What would you do if these devices were not there?

•	 What would you want these devices to do?

ACTIVITY TIME

In the computer lab, collect pictures of AI devices using the internet. Print the 
pictures and make a collage.

LET'S EXPLORE

•	 Recapitulate the AI discussed in the previous classes. 

•	 Explain how AI enabled devices help us in our everyday life with examples.

•	 Ask the students to list some AI enabled devices and what do they use these 
devices for.

FOR THE TEACHER

	 2. 	� How does AI help us in navigation?

	 3. 	� What is smart input?

	 4. 	� What are smart speakers?

	 5. 	� How does a self-driving car operate?

SEL CM

EL CRTE
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PERIODIC ASSESSMENT 4

A.	 Identify the following images and write their names.

	     					   

		  1.  			   2. 

	 	     	 	 	 	 	   

		  3.  			   4. 

B.	 Fill in the blanks using the words given below.

	
MICROSOFT OFFICE  NAME  DIGITAL  TOUCH SCREEN  OPEN

		  1. � Every folder has a specific .

		  2. � A smart lock uses  key key to lock a door.

		  3. � Double-click on a folder to  it.

		  4. � A smartwatch is operated through a .

		  5. � To create a Word file, we have to click on Start button and then 
. 
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CHAPTER—1, 2, 3

A.	 Identify the following images and write their names.

	 	   					      

		  1.  			   2. 

	 	   					   

		  3.  			   4. 

B.	 Fill in the blanks using the words given below.

	 laptop  eat  computer  study  information

		  1.   is the brain of a computer.

		  2.  Computer needs  to run.

		  3.  A computer cannot  and breathe.

		  4.   has colourful beads used for counting.

		  5.  A computer can store a large amount of .

TEST PAPER 2TEST PAPER 2

A.	 Choose the correct option.
	 1.	  selection is used to select irregular parts of a picture.

		  a.	 Rectangular	 	 b.	 Free-form	 	 c.	 Circular	

	 2.	 In MSW LOGO, the turtle has  parts.

		  a.	 two	 	 b.	 three	 	 c.	 four	

	 3.	 Folder inside a folder is called .

		  a.	 sub-folder	 	 b.	 file	 	 c.	 new folder	

	 4.	  TVs can be connected to the Internet.

		  a.	 Smart	 	 b.	 Antique	 	 c.	 Driverless	

	 5.	 In MSW LOGO,  button clears the main screen.

		  a.	 execute	 	 b.	 halt	 	 c.	 reset	

B.	 Write (T) for true statement and (F) for false statement. 

	 1.	 Paint cannot modify pictures.�

	 2.	 BK command moves the turtle forward.�

	 3.	 Every folder has a specific name.�

	 4.	 Chatbot is used for face-recognition.�

	 5.	 AI made travel more convenient.�

C.	 Answer the following questions.

	 1.	 What is meant by flip a picture and how can you use it in Paint?
	 2.	 What is commander window of MSW LOGO?
	 3.	 How can you create a file in Microsoft Word?
	 4.	 How does AI help in navigation?
	 5.	 Name any five tools of Paint with their uses. 

112 Test Paper 2
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A.	 Type the given document in MS Word.

	

Dear Anjali,

I am throwing a party for my birthday on 6th January. 
Venue for the party is my home. Some other friends are 
also invited to the party. You are also invited for that.

Kindly, join us for my birthday party.

With love
Varsha

	 1.	 �Write your friend's name in place of Anjali and your 
name in place of Varsha.

	 2.	 Save it as a file with the file name “Invitation”.

B.	 Draw the given image in MS Paint.

	

	 1.	 Add more fish by using copy and paste commands.
	 2.	 Change the sizes of the fish.
	 3.	 Turn some fish at an angle by using skew command.
	 4.	 Change the direction of some fish.

PROJECTPROJECT

113Project

Computer G3_Ch-9.indd   113Computer G3_Ch-9.indd   113 27-02-2023   10:52:0027-02-2023   10:52:00



114 National Cyber Olympiad

LOGICAL REASONINGLOGICAL REASONING

1.	 Select the option which completes the given pattern.

		  a.	 	 b.	 	 c.	 	 d.	

2.	 In how many different ways the rat can reach the cheese?

		

		  a.	 6	 b.	 7	 c.	 8	 d.	 9

3.	� If ‘Star’ is called ‘Sun’, ‘Sun’ is called ‘Moon’, ‘Moon’ is called ‘Earth’ and ‘Earth’ 
is called ‘Comet’, then man lives on .

		  a.	 Earth	 b.	 Comet	 c.	 Earth	 d.	 Star

COMPUTERS AND INFORMATION TECHNOLOGY

4.	 Select the shape that is available in MS Paint.

		  a.	 	 b.	 	 c.	 	 d.	

5.	 Which of the following is the image of a modern computer?

		  a.	 	 b.	 	 c.	 	 d.	

NATIONAL CYBER OLYMPIADNATIONAL CYBERNATIONAL CYBER  OLYMPIADOLYMPIAD
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6.	� Select the incorrect match of brushes and their names in MS Paint of 
Windows 10.

		  a.	  Brush	 b.	  Airbrush	 c.	  Marker	 d.	  Oil brush

7.	 Select the odd one out.

		  a.	 MS Word	 b.	 Tux Paint	 c.	 Google Chrome	d.	 Monitor

8.	 Select the incorrect statement about Windows 10.

		  a.	 Windows 10 has a Graphic User Interface (GUI).

		  b.	 It has introduced Cortana.

		  c.	 It was launched in 2010.

		  d.	 It is an operating system.

9.	 The shortcut key for copy is .

		  a.	  + 	 b.	  + 	 c.	  + 	 d.	  +  

10.	 Which of the following is not a search engine?

		  a.	 Google Chrome		 b.	 Mozilla Firefox

		  c.	 MS Paint			   d.	 Microsoft Edge

11.	� The Arithmetic and Logic Unit controls the  in 
the computer.

		  a.	� Performance of all arithmetic and logical operations

		  b.	� Flow of electricity within the computer

		  c.	� Storage of data in computer

		  d.	� Transfer of data and instructions
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12.	 MS Word is a software that is used for .

		  a.	 writing documents	 b.	 drawing purposes 

		  c.	 calculations			   d.	 searching

13.	 Choose the odd device out.

		  a.	 	 b.	 	 c.	 	 d.	

ACHIEVERS SECTION

14.	� Ashmita wants to create a folder, so that she can store her school pictures at 
a single location on the desktop. But she does not know the correct sequence 
of steps required to follow to create a folder. Help her by rearranging the 
given steps in the correct sequence.

		  1.	 Change highlighted text to “School Pictures” and press Enter.

		  2.	 Right-click on the blank space of the desktop. A list will appear.

		  3.	 A new folder is created.

		  4.	 Click on New option, another list will appear.

		  a.	 → 3 → 2 → 5 → 1 → 4	 b.	 2 → 4 → 5 → 1 → 3

		  c.	 2 → 5 → 1 → 4 → 3	 d.	 2 → 1 → 4 → 5 → 3

15.	 Identify the following.

		  1.	 It is a search engine.

		  2.	 It is Microsoft software.

		  a.	 	 b.	 	 c.	 	 d.	
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